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Automatically Update 
When you are modifying styles, if you check the box for automatically update, any 

formatting changes you make manually to text that has a style applied to it will 

automatically cause that formatting to be applied to that style throughout the document.  

 

Styles stay with the document, so when you transfer them from one computer to another, 

they should retain their formatting. However, if you have the Automatically Update 

Document Styles box checked, your styles may get overridden.  

Create Styles  
Styles are predetermined formats that can be customized the way you want them. In 

Word, for example, you could create a style that would make your text Size 16, Times 

New Roman, Red and Underlined. Then you would simply click on the appropriate style 

button on the home ribbon to select your particular style. Styles allow workgroups to use 

consistent formatting no matter who is working on the document. If you change your 

mind (I know, that never happens!), you change the formatting in one place (the style 

itself) and it is automatically applied throughout the document.  

 

To use a style, you can click on the style name, then start typing, or type your text, select 

it (highlight it) and click the style name. 

 

To access styles, click Styles on the Home Ribbon. You can create a brand new style by 

clicking Save Selection as New Quick Style. First you need to assign a name to your 

style. Make it something easy to remember and easy to distinguish from any other styles 

that you create. Then you need to decide if your style will be paragraph or character 

based. A paragraph style has formatting features that apply to the entire paragraph. By 

default the paragraph styles will be applied to the entire paragraph. A character style 

includes only formatting that applies to individual text.  

Cross References 
Cross references allow you to use location references (such as “See page x for more 

information”). Cross references can point to text that has heading styles applied to it and 

it can reference the text itself or the page the heading style appears on.  

 

Go to the place you want to point FROM and click Insert – Cross Reference. Change the 

reference type to Heading and insert a reference to the Heading Text or Page Number. 

Note that you could also refer to many other things, like tables, pictures, etc.).  

 

Cross references will update automatically when you print, print preview or save your 

document. To manually update, right mouse click on the cross reference field and choose 

Update Field, update entire table.  

 

For (some) fields to update on print, you must select the "Update fields  

before printing" option at File tab | Options | Display. 
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Format Painter  
The Format Painter is an extremely useful feature. This button, on your standard toolbar, 

looks like a paintbrush and allows you to copy formatting from one spot to another.  

 

Place your cursor in the paragraph that contains the formatting you want. Press the 

Format Painter button once. Your mouse changes to an I-bar with a small paintbrush next 

to it. Select the text you want to change, and the formatting (color, size) is automatically 

copied to the selected text.  

 

If you only want to copy character formatting (font color, size, typeface, etc.), then don’t 

select the paragraph marker of the formatted text you want to use. If you want to copy 

paragraph formatting (line spacing, indenting, etc.), make sure that you have the 

paragraph marker selected before you click the Format Painter.  

 

If you want to apply the formatting in several locations, double clicking on the Format 

Painter button will leave the feature on, even after you have clicked the first time to apply 

the formatting. You can then copy the text to multiple locations within the document. 

Clicking the button again (once) turns the feature off. 

 

The Format Painter can fix numbering inconsistencies. If you have a numbered list, then 

several paragraphs without the numbering, and you want to continue the numbered list, 

the Format Painter can help. Just click on the line where the numbering is correct, then 

click the Format Painter, then select the line(s) you want numbered. Voila! Numbering 

fixed.  

Insert Chapter Name into Header/Footer 
Apply the appropriate heading style to the text you will want to appear in header or 

footer. Note that if you are using the same heading style but don’t want to include all the 

text, make a custom style based on that heading and apply that instead.  

 

Go to Insert-Header-Edit Header. Click on Insert – Quick Parts – Field – Styleref. Choose 

the correct heading style from the list. Voila! You will now have the chapter title text 

included automatically in your header.  

 

The StyleRef field inserts text that's formatted with the specified style. When inserted in a 

header or footer, the StyleRef field prints the first or last text formatted with the specified 

style in the document body of the current page, allowing you to print dictionary-style 

headers or footers.  

 

 Clicking the box to Search from the bottom to the top puts in the text from the last 

reference with that style instead of the first.  

 

 Clicking the box to Insert paragraph number will insert the number of the 

numbered heading style.  
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 Clicking the box to Insert paragraph number in a relative context will insert 

Above or Below as appropriate.  

 

 Clicking the box to Suppress all non-delimiter characters will insert the paragraph 

number of the numbered heading style without any text, so Section 1.01 becomes 

1.01.  

 

 Clicking the box to Insert the number in full context will insert the paragraph 

number with a full path (i.e. if you have level 1 be 1, level 2 be a, level 3 by I, full 

context would be 1.a.I).  

 

When you insert the field in: 

 

 Document text: Word searches backward from the StyleRef field for the specified 

style. If the style isn't found, Word searches forward from the StyleRef field. 

 Footnotes, annotations, and endnotes: Word searches backward from the footnote, 

annotation, or endnote reference mark for the specified style. If the style isn't 

found, Word searches forward from the reference mark. 

 Headers and footers (results for printed document): Word searches the current 

page, from top to bottom, for the specified style. If the style isn't found, Word 

searches next from the top of the page to the beginning of the document, and then 

from the bottom of the page to the end of the document. If the \l switch is used, 

Word searches from the bottom of the page to the beginning and then to the end 

of the document. 

 Headers and footers (results for electronic document): Word searches the section 

that contains the StyleRef field, from the beginning, for the specified style. If the 

style isn't found, Word searches from the end of the section to the end of the 

document. 

Keyboard Shortcuts 
Some common keyboard shortcuts you might find useful.  

 

Ctrl-b – Bold (toggles on and off) 

Ctrl-I – Italic 

Ctrl-U – Underline 

Ctrl-[ - decrease font 1 point 

Ctrl-] – Increase font 1 point 

Ctrl-Spacebar – Removes character formatting 

Ctrl-Shift-N – Applies normal formatting 

Ctrl-Q – Clears manually applied paragraph formatting 

Ctrl-Shift-C – Copies text formatting 

Ctrl-Shift-V – Pastes text formatting 
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Modifying Styles 
To modify an existing style, right mouse click on the appropriate style button and click 

Modify. From the Modify Style window, you can change the formatting of the font, 

paragraph, tab, borders, frame, and language settings. The windows that appear with each 

of these options will match the windows that would appear if you chose them from the 

font or paragraph ribbon groups, but your modifications will be applied to the style itself, 

not just the highlighted text. 

 

If you check the box for automatically update, any formatting changes you make 

manually to text that has a style applied to it will automatically cause that formatting to 

be applied to that style throughout the document.  

 

Checking the box to Add to Template will add this style to the template that was used to 

create the document. By default, styles are only associated with the document that they 

were created in. Therefore, if you modify the formatting of Heading 1 for instance, it 

would only affect the open document and not every other new document that is 

subsequently created. 

Navigation Pane 
The Navigation Pane is a pane that opens on the left side of your screen and only shows 

text that has heading styles applied. It will allow you to click on any of those section 

headings to move easily through the document. This is especially useful if you are 

working with a large document. 

 

Note that you can click and drag the heading references and it will drag the entire section 

to the new location. 

Quick Access Toolbar 
To add buttons to your quick access toolbar, right mouse click on the toolbar, then choose 

Customize Quick Access Toolbar. Change Choose Commands list to All Commands. 

Select the one you want, click add. Can select for current document or all documents. To 

rename or change icon, select it in list and click Modify.  Display Name is the screen tip 

that pops up when you hover your mouse. 

Quick Styles 
After you apply styles, you can quickly change the look of the document to suit your 

needs by choosing the Quick Style set that you like. You can refine the look of the 

document even more by selecting a theme that you like. Within the Quick Style and 

theme parameters, you can also fine tune adjustments to the color and font schemes. 

 

Themes provide font and color schemes for Quick Style sets. When you apply a theme, 

you simultaneously apply a font scheme, a color scheme, and a set of graphic effects. The 

font scheme and color scheme from the theme are carried over into the Quick Style sets. 

 

Applying custom font choices 
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Applying a theme or a font scheme defines font choices for headings and body text that 

are designed to go together. The font choices stay in effect regardless of which Quick 

Style set you choose, until you switch to a different theme or font scheme. 

 

NOTE   If you don't want the font to update to reflect updates to the theme or font 

scheme, be sure to format the text with a font whose name is not followed 

by (Headings) or (Body). These are listed as Theme Fonts in the gallery of fonts. 

 
1. The fonts that you select among the Theme Fonts will be updated to a different font 

scheme if you apply a different theme or font scheme to the document. 

2. Click a font among the Recently Used Fonts or All Fonts to quickly apply a font that 

is not subject to changing the theme or font scheme. 

 

Applying custom color choices 

You can apply a color scheme that is designed as a coordinated set of colors. When you 

define the color of text, you can choose one of the theme colors, or you can select from a 

range of standard and custom colors. 

 

If you choose a theme color, the color might change if you switch to a different color 

scheme or theme. However, if you choose a standard or custom color, text is displayed in 

that color regardless of the color scheme or theme that you apply to the document. 

 

1. Colors that you select from the Theme Colors are updated 

to a different color scheme if you apply a different theme or 

color scheme to the document. 

2. Colors that you select from the Standard Colors are not 

changed even if you apply a different theme or color scheme to 

the document. 
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3. Click More Colors to select from a wide array of color choices. These colors also are 

not changed even if you apply a different theme or color scheme to the document. 

Palettes of choices for applying layers of formatting 

 

Let's put all these formatting choices together. Think of themes as palettes that provide 

font and color schemes, and Quick Style sets are like collections of brushes that you use 

to apply formatting to your document. The palettes are labeled things like Office, Apex, 

and Aspect. The brush collections are named things like Word 2007, Manuscript, and 

Traditional. Each brush collection is prestocked with brushes named Normal, Heading 1, 

Emphasis, and so on. 

 

When you apply brush strokes (styles) to your document, Word applies the formatting in 

layers. Each layer overrides the previous layer, providing an increasing degree of fine-

tuning and a decreasing degree of flexibility. 

 

The bottom layer is the Normal paragraph style. Text formatted as Normal can 

automatically change its appearance when you switch themes or Quick Style sets. The top 

layer is direct formatting. If you select a word and apply the standard red color to it, the 

word remains red no matter what theme, Quick Style set, or style you apply to it. 

 

Emphasize or italicize? 

For example, if you are using the Word 2007 Quick Style set, and you want to emphasize 

a word in a paragraph, you can select it and then do one of two things: 

 Format it with the Emphasis Quick Style. 

 Italicize it (for example, by pressing CTRL+I). 

The choice you make depends on whether you want to emphasize the text or italicize it. 

Emphasized text contrasts with the surrounding text, but it doesn't necessarily need to be 

italicized. On the other hand, you may want to use italics if the text is a book title. 

When you use the Word 2007 Quick Style set, the Emphasis style italicizes the text. 

However, if you switch to the Fancy Quick Style set, the body text is displayed in italics, 

and text formatted with the Emphasis style is displayed in a contrasting color with a 

shaded background. If you switch to the Elegant Quick Style set, text formatted with the 

Emphasis style is displayed as bold, small caps. 

The Emphasis style is a design element within the Quick Style set, not an explicit format. 

 

Customized styles 

If you want formatting choices that are not available from the built-in styles, Quick Style 

sets, and themes, you can create custom styles to suit your needs. 

The easiest way to create a custom style is to modify a built-in style and then save it as a 

new style. 

For example, you might want to format a paragraph of quoted material with a half-inch 

indent from the left and right margins, single spaced. There is no built-in style to 

accommodate this, but you can create a custom style by doing the following: 

1. Click in the paragraph you want to format. 

2. On the Home tab, click the Paragraph Dialog Box Launcher. 
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3. In the Indentation section, type 0.5" in the Left and Right boxes. 

4. In the Spacing section, in the Line spacing list, click Single. 

5. Click OK. 

6. Right-click in the paragraph, point to Styles, and then click Save Selection as a 

New Quick Style. 

7. In the Name box, type a name for the style, such as Block quote. 

8. If you want the style to be included in the gallery of styles on the Home tab, and 

if you want the style to be a linked style, click OK. 

9. If you don't want the style to be included in the gallery, or if you want the style to 

be either a paragraph or a character style, click Modify and do one or both of the 

following: 

o At the bottom of the dialog box, clear the Add to Quick Style list box. 

o In the Style type list, click Paragraph or Character. 

Table of Contents 
A Table of Contents is the listing at the beginning of a document that details all the 

sections with their appropriate page numbers. Word can generate a table of contents 

automatically when you have Heading Styles or custom styles that are based on Headings 

applied to the text. All you have to do is click where you want to insert the table of 

contents, then click on References – Table of Contents – Insert Table of Contents (or 

select one of the preformatted options). You will see a preview to show you what your 

table of contents will look like. Usually they only go down to three levels, but you can 

modify that to include more levels. You can choose to show page numbers or not. On the 

bottom half of the window you’ll see an option for formats. These are pre-designed table 

of content styles. Traditionally each level is indented, but that can be modified. To 

change the formatting, click on the Modify button in the bottom right corner. 

 

Select the style on the left (TOC1 is the first level of the table of contents, which usually 

is matched with the Heading 1 Style), then click Modify.  

 

The window that comes up when you click on Modify gives you the option to change the 

name of your style. Then you can click the Format button, which will allow you to 

modify font, paragraph, tab, borders, frame, and numbering settings. The windows that 

appear with each of these options will match the windows that would appear if you chose 

them from the Format menu.  

 

From this window you can also check the box to automatically update future changes. 

When this option is checked, you can manually change the table of contents formatting 

and the style will be updated throughout the table of contents. 
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You can update the table of contents at any time by right mouse clicking on top of it and 

choosing Update Field. Then you will choose to update the page numbers only or the 

entire table (which would update any text changes that you made). Click OK. Voila! 

 

I normally update my entire document at one time, by pressing Ctrl-A (shortcut to select 

all text in document), then right mouse clicking and choosing Update Field. This will 

update your table of contents and all cross references or fields throughout the document. 

Types of Styles 
Paragraph styles are marked with a paragraph symbol: ¶. You can see the paragraph 

symbol in the Quick Style gallery as well as in the Styles task pane. Click anywhere in a 

paragraph to apply the style to the entire paragraph. 

 

Character styles are marked with a character symbol: a. Click anywhere in a word to 

apply the style to the entire word. Or you can select more than one word to apply the 

style to more than one word. Character Styles can only hold character formatting, 

primarily font characteristics, such as italic formatting and font color. 

 

Linked styles are marked with both a paragraph symbol and a character symbol: ¶a. 

Click anywhere in a paragraph to apply the style to the entire paragraph. Or you can 

select one or more words to apply the style to the words that you selected. 

 

Character styles 
Character styles contain formatting characteristics that can be applied to text, such as font 

name, size, color, bold, italic, underline, borders, and shading. 

 

Character styles do not include formatting that affects paragraph characteristics, such as 

line spacing, text alignment, indentation, and tab stops. 

 

Word includes several built-in character styles, such as Emphasis, Subtle Emphasis, and 

Intense Emphasis. Each of these built-in styles combines formatting, such as bold, italic, 

and accent color, to provide a coordinated set of typographic designs. For example, 

applying the Emphasis character style formats text as bold, italic, in an accent color. 

 

To apply a character style, you select the text that you want to format, and then you click 

the character style that you want. 
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1. Click in the word you want to format. 

2. Mouse over the Quick Styles to see a preview of the formatting in your document. 

When you point to a character style, only the word where you clicked is formatted. When 

you point to a paragraph style or a linked style, the entire paragraph is formatted. Click 

the character style that you want to use. 

3. The word that you selected is formatted with the characteristics of the style that you 

chose. 

 

Paragraph styles 
A paragraph style includes everything that a character style contains, but it also controls 

all aspects of a paragraph's appearance, such as text alignment, tab stops, line spacing, 

and borders. 

For example, you can have a character style called Alert that formats text as bold and red. 

Additionally, you can have a paragraph style called Headline that formats text as bold 

and red. But the Headline paragraph style also centers the text horizontally and adds 24 

points of space above the text. 

In this scenario, if you select a paragraph and then apply the Alert style, all the text in the 

paragraph is formatted as bold and red, but nothing else about the paragraph changes. 

However, if you select the paragraph and then apply the Headline style, the text become 

bold and red, extra space is inserted before the paragraph, and the paragraph is centered 

between the left and right margins. 

Word includes two built-in paragraph styles: Normal and List Paragraph. By default, 

Word automatically applies the Normal paragraph style to all text in a blank, new 

document. Similarly, Word automatically applies the List Paragraph paragraph style to 

items in a list — for example, when you use the Bullets command to create a bulleted 

list. 

To apply a paragraph style, you select the paragraphs that you want to format, and then 

you click the paragraph style you want. 

NOTE   To select a single paragraph for applying a paragraph style, you can click 

anywhere in the paragraph. To select more than one paragraph, click anywhere in the first 

paragraph and drag to anywhere in the last paragraph that you want to select. You do not 

need to select the entire paragraph. 

 

Linked styles 
A linked style behaves as either a character style or a paragraph style, depending on what 

you select. If you click in a paragraph or select a paragraph and then apply a linked style, 

the style is applied as a paragraph style. However, if you select a word or phrase in the 

paragraph and then apply a linked style, the style is applied as a character style, with no 

effect on the paragraph as a whole. 

For example, if you select (or click in) a paragraph and then apply the Heading 1 style, 

the whole paragraph is formatted with the Heading 1 text and paragraph characteristics. 

However, if you select a word or a phrase and then apply Heading 1, the text that you 

selected is formatted with the text characteristics of the Heading 1 style, but none of the 

paragraph characteristics are applied. 
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1. When you select or click in a paragraph and apply a linked style, the style is applied to 

the whole paragraph. 

2. When you select a word or phrase and apply a linked style, the style is applied only to 

the selected text. 

How is this useful? Consider the scenario above, in which an Alert character style and a 

Headline paragraph style each format text as bold and red. If the Headline style were a 

linked style instead of a paragraph style, you would not need a separate character style for 

formatting words and phrases. Wherever you wanted a headline in your document (bold, 

red, centered, with extra space above), you would select a paragraph and apply the linked 

style. Wherever you wanted an alert, you would select a word or phrase and apply the 

same linked style. 

Word includes many built-in linked styles, notably the heading styles (Heading 1, 

Heading 2, and so on). 

TIP   You might want the first few words of a paragraph to coordinate with the 

formatting of the headings in your document. This type of formatting, known as a run-in 

head or a side head, is easy to apply by using linked styles. Select the first few words of a 

paragraph, and then apply a heading style. 
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1. Select the first few words of a paragraph and then click a heading style to create a run-

in head. 

2. Click in a paragraph and then click a heading style to create a heading. 

 

List styles 
A list style applies characteristics for formatting a list. A list can include levels of 

hierarchy, like an outline, that can be indicated by indentation and numbering schemes. 

For example, level one in a multilevel list can be aligned against the margin and can 

begin with an Arabic numeral followed by a period. Level two can be indented slightly 

from the margin and can begin with a lowercase alphabetical character followed by a 

closing parenthesis. Here is an example of a multilevel list that is two levels deep: 

1. This is the first item at level one. 

   a) This is the first item at level two, within the first item at level one. 

   b) This is the second item at level two, within the first item at level one. 

2. This is the second item at level one. 

   a) This is the first item at level two, within the second item at level one. 

3. This is the third item at level one. 

   a) This is the first item at level two, within the third item at level one. 

   b) This is the second item at level two, within the third item at level one. 

   c) This is the third item at level two, within the third item at level one. 

 

A list style can define formatting for as many as nine levels of a list. The formatting 

scheme can include paragraph indentation for each level of the list, any label text (such 

as, "Item" or "Chapter"), and the numbering or bullet characters to use in the list. 

 

Unlike the other types of styles (paragraph, character, linked, and table), predefined list 

styles are not available when you first create a document in Word. 

 

NOTE   A document may contain list styles if you receive it from someone who created 

his or her own list styles. If your document contains list styles, they are listed under 

the List Styles heading in the gallery of multilevel lists. To see that gallery, 

click Multilevel List in the Paragraph group on the Home tab. 



Copyrighted – MRH Enterprises LLC  13 

Please do not duplicate without permission. 

 
 

List Library: the starting point for list styles 

Instead of predefined list styles, Word provides several multilevel list templates, which 

are displayed under the List Library heading in the gallery of multilevel lists. These 

preformatted designs can be applied to lists in your document, and they can also serve as 

a handy starting point for creating your own list styles. 

 

Consider creating your own list style when you want to do the following: 

 Change list formatting consistently throughout your document    After list 

styles are defined and applied, they can be changed. The changes affect all 

instances where the list style is used in the document. 

 Use complex list formatting that varies from one multilevel list design to 

another    List styles provide great flexibility, and each one is named separately, 

which makes it easier to distinguish among them in the list of list styles. 

 Apply formatting to a multilevel list by using a keyboard shortcut    You can 

assign keyboard shortcuts to list styles that you create, but not to the preformatted 

multilevel list templates. 

 

TIP   If you use the built-in heading styles in your document (Heading 1, Heading 2, and 

so on), you can use multilevel list templates to apply a numbering scheme to your 
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headings. For example, to number headings so that top-level headings (Heading 1 

paragraphs) are numbered 1, 2, 3, second-level headings (Heading 2 paragraphs) are 

numbered 1.1, 1.2, 1.3, and so on, you click in the first Heading 1 paragraph, and then 

under List Library you click 1 Heading 1, 1.1 Heading 2, 1.1.1 Heading 3. Multilevel 

list templates that number headings are marked in the list gallery with Heading in gray 

text. 

 
Create your own list style 

The easiest way to create a list style is to start with one of the preformatted multilevel list 

templates. 

1. Select the list that you want to format. 

2. On the Home tab, in the Paragraph group, click the arrow next to Multilevel 

List. 

3. Under List Library, click the design that most closely matches how you want 

your list style to look. 

4. Click Multilevel List again, and then click Define New List Style. 

5. Make any modifications you want to the preformatted design. 

6. In the Name box, type a name for your list style. 

7. If you want your list style to be available for all new documents that you create, 

click New documents based on this template. 

 

Table styles 
A table style provides a consistent look to borders, shading, alignment and fonts in tables. 

To apply a table style, you select the table that you want to format, and then you click a 

table style from the gallery of table styles on the Design tab, on the Table 

Tools contextual tab. Within a table cell, you can use styles and direct formatting to 
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format the content of the cell. Formatting that you apply this way overrides the 

formatting that comes from the table style. 

In other words, if you use a style or direct formatting to format the content of a table cell 

and then you switch to a different table style, the content that you formatted with the style 

or direct formatting is not updated to match the new table style. 

 
1. You can apply formatting to the content of a table, such as changing the header row to 

blue. 

2. When you switch to a different table style, the header row remains blue. 

TIP   You can change the selection of table styles in the gallery by selecting or clearing 

check boxes in the Table Style Options section on the Design tab, before you open the 

gallery of table styles. For example, if your table has no header row, and you don't want 

rows to alternate shading, clear the Header Row and Banded Rows check boxes. When 

you open the gallery of table styles, you see previews that do not include formatting for 

header rows or banded rows. 
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prepared by professionals, they should not be used as a substitute for professional services. If legal or 
other professional advice is required, the services of a professional should be sought. 

The opinions or viewpoints expressed herein do not necessarily reflect those of Lorman Education 
Services. All materials and content were prepared by persons and/or entities other than Lorman 
Education Services, and said other persons and/or entities are solely responsible for their content. 

Any links to other websites are not intended to be referrals or endorsements of these sites. The links 
provided are maintained by the respective organizations, and they are solely responsible for the 
content of their own sites. 


